
 
 

 

 

 

 

 

 

SimuLEDView 

 

 

 
 

Visualization Tool for the SimuLED Software Package 

 

 

 

 

 

User Manual 

 

 

 

 

Version 4.12 



 
 

 

    

SimuLEDView User Manual 2 of 19 

 

 
STR IP Holding, LLC, Richmond, VA, USA  

Copyright ©  2005-2012 by STR IP Holding, LLC.   
All rights reserved. Published 2012. 

 
 
 
 
 
 

This manual is the confidential and proprietary product of STR IP Holding, LLC. Any unauthorized 
use, reproduction, or disclosure of this manual is strictly prohibited. (Subject to limited use within 

the STR End-User License Agreement only.) 
 
 
 
 
 
 
 

CGSimTM, VRTM, PolySimTM, CVDSimTM, HEpiGaNSTM, SimuLEDTM, SiLENSeTM, RATROTM, 
SpeCLEDTM, SimuLAMPTM, SELESTM, FETISTM are registered trademarks, brands, and 

proprietary products of STR IP Holding, LLC. 

 
 
 
 
 
 
 
 

User Support: SimuLED-support@str-soft.com 
Software Sales: STR-sales@str-soft.com 
Phone: +7 812 320 4390                   Fax: +7 812 326 6194 
STR Group Ltd.                                        www.str-soft.com 
Engels av. 27, P.O. Box 89, 194156, St. Petersburg, Russia 



 
 

 

    

SimuLEDView User Manual 3 of 19 

 

Table of Contents 
 

1 Introduction 4 

2 Getting Started 4 

3 Integral Parameters 6 

4 Planar Distributions 8 

4.1 Variables 8 
4.1.1 SpeCLED Output Files 8 
4.1.2 RATRO Output Files 9 

4.2 Frames 10 

4.3 Flood 11 

4.4 Contour 11 

4.5 Vector Field of the Electric Current 12 

4.6 Die Domains and Computational Grid 13 

4.7 Probe 13 

4.8 Calculator 17 

4.9 Image Options 17 

5 Radiation Pattern 18 

6 RATRO 3D View 19 

 



 
 

 

    

SimuLEDView User Manual 4 of 19 

 

1 Introduction 

SimuLEDView is a visualization module supplied with SimuLED software package. It 

provides visualization of the current spreading and heat transfer computations made by 

SpeCLED and ray tracing computations made by RATRO. 

 

2 Getting Started 

 

Fig. 1 

Results generated by SpeCLED program are organized in three main parts: 

� A set of integral quantities calculated for the whole chip. This information is 

presented in the Report section available on pressing the Report button at the right 

hand side of the window. If several files with the same chip at different biases are 

loaded, the integral characteristics can also be plotted as functions of bias using the 

Integral menu item 
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� 2D distributions across the active region of heterostructure and a set of planar 

horizontal die cross-sections. This is presented in the main graphics window of the 

SimuLEDView in the Main mode.  

� 1D plots of the integral characteristics calculated for the whole chip, such as 

emission spectrum.  This is presented in the main graphics window of the 

SimuLEDView in the Spectrum mode. Selection of the graphics window mode is 

available using a combo box on top of the graphics window at the left hand side. 

 
Results generated by RATRO program are organized as follows: 

� Integral quantities calculated for the whole chip, namely top and bottom extraction 

coefficients. This information is presented in the Report section.  

� 2D distributions across  

� the top and bottom surfaces of the sphere of a given radius (far-field region) 

and  

� all surfaces of the chip (near-field region). 

� Radiation patterns computed for the far-field region. They are available using the 

Radiation Pattern item of the Probe menu. 

� 3D visualization of light intensity distributions for near-field emission. 

 
 
The SimuLEDView program works with *.cgs files containing the results of computations. 

The name of a file created by SpeCLED solver is formed from the name of the project (i.e. 

the name of the corresponding *.dvx file) by adding the Bias value to the end. For example, 

computations for the geometry defined in Test1.dvx for bias of 3.5 V are stored in file 

Test1(3.5).cgs. It can contain the following information: 

� Distributions across the Active Region. 

� Integral chip characteristics. 

� Emission spectrum (this is available if the I-V characteristics of the active region are 

imported into SpeCLED from files generated by SiLENSe, which contain information 

on the spectral characteristics of the active region). 

� Distributions across metal electrodes. 

� Distributions across horizontal die cross-sections (Z-planes).  

 

The name of a file created by RATRO solver is formed from the name of the input cgs file 

generated by SpeCLED project by adding “_rtr” suffix to the end. For example, computations 

for the geometry defined in Test1.dvx for bias of 3.5 V are stored in file Test1(3.5)_rtr.cgs. 
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The data are loaded into SimuLEDView using the File menu containing the following items: 

� Open As New opens an individual file resetting all visualization options.    

� Open As Previous opens an individual file keeping most visualization options 

defined by the user.    

� Load Active Zone Files allows the user to load a group of SpeCLED files containing 

active region information (without Electrodes and Z-Planes) corresponding to the 

same geometry but different value of the Bias.   

3 Integral Parameters 

SimuLEDView provides a set of integral quantities corresponding to the whole chip and 

overview of chip parameters at which the computations have been made, which include  

� For SpeCLED computations: 

� Light extraction efficiency. 

� Forward bias 

� Total current 

� Output power  

� Wall-plug efficiency 

� Average and maximum current density 

� Average and maximum p-n junction temperature 

� Dissipated power in active region, electrodes and contact layers 

� For RATRO computations: 

� List of materials with refraction and absorptions indices 

� List of surfaces types with assigned surface parameters  

� List of all chip surface with light extraction through the given surface 

� Total light extraction efficiency (sum of light extraction over all surfaces)  

 

This information is presented in the Report section at the right hand side of the window. The 

Report section opens on pressing the Report button at the right hand side of the window.  

The button Report Tools switch the report to editable mode, allowing the user to format the 

report or/and add some comments.  
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Fig. 2 

If several files containing distributions over the active region on the same chip at different 

biases are loaded (using the File -> Load Active Zone Files menu item), the integral 

characteristics are plotted as a function plots of bias. This is available using the Integral 

menu item, which opens the Integral Characteristics dialog window (see Fig. 2) that plots 

the following dependencies: 

� Voltage and light emission as a function of total current. 

� External and wall-plug efficiency as a function of total current. 

� Maximum current density as a function of total current. 

� Average and maximum chip temperature as a function of total current. 
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� Differential resistance as a function of current. 

� In addition to graphs, all dependencies are also available in text table format which 

can be exported to be viewed using an external visualization tool.  

4 Planar Distributions 

4.1 Variables 

2D planar distributions of various variables are presented in the graphics window of 

SimuLEDView. The view of graphics window is governed by a combo box on top of the 

window at the left hand side. To visualize the planar distributions Main mode should be 

selected in this combobox.  

 

On bottom of the graphics window a set of tabs is located, allowing the user to specify the 

variable to be shown. Each variable is shown in its own tab window.  

4.1.1 SpeCLED Output Files 
The following variables are available in the SpeCLED results: 

� For active region: 

� T (K) – temperature 

� Jz (A/cm2) – vertical component of the current density 

� JunctionBias (V) – p-n junction bias 

� IQE (%) – local internal quantum efficiency 

� Emission_Power_Density (W/cm2) – light power generated in the active 

region (The total output power presented in Report is given by integration 

of this distribution over the active region and subsequent multiplying by 

the external light extraction efficiency).    

� Wavelength (nm) – local maximum of the emission spectrum  

� HeatSourceSurf (W/cm2) – heat release in the active region 

� For electrodes and pads: 

� T (K) – temperature 

� Potential (V) – electric potential on the electrode surface 

� Jx (A/cm2), Jy (A/cm2) and Jz (A/cm2) – components of the current density 
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� PotDropSurf (V) – potential drop between the electrode and semiconductor 

because of the contact resistance 

� HeatSourceVol (W/cm3) – volumetric heat release due to Joule heat sources 

� HeatDropSurf (W/cm2) – surface heat release due to contact resistance 

� ElectricalCond ((Ω.cm)-1) – electric conductivity 

� ThermalCond (W/(m.K)) – thermal conductivity 

� Z-Planes: 

� T (K) – temperature 

� Potential (V) – electric potential on the electrode surface 

� Jx (A/cm2), Jy (A/cm2) and Jz (A/cm2) – components of the current density 

� HeatSourceVol (W/cm3) – volumetric heat release due to Joule heat sources 

� ElectricalCond_XY ((Ω.cm)-1) – lateral electric conductivity 

� ElectricalCond_Z ((Ω.cm)-1) – normal electric conductivity 

� ThermalCond (W/(m.K)) – thermal conductivity 

� Vertical crossection: 

� T (K) – temperature 

� Potential (V) – electric potential on the electrode surface 

� Jx (A/cm2) and Jz (A/cm2) – components of the current density 

4.1.2 RATRO Output Files 
The RATRO results include: 

� For Far-Field Region: 

� Radiant Intensity (W/sr) 

� Radiance (W/(sr.m2)) 

� Luminous Intensity (cd) 

� Luminance (cd/m2) 

� Polarization – the ratio of extracted TE and TM rays defined as (TE-

TM)/(TE+TM) 

� For Near-Field Region: 

� Intensity (W/cm2) – output power of the light emission at the active region at 

each individual chip surface 

� Model – type of surface. An integer value from 0 to 6 presenting the index of 

the local surface type. The surface types with their indices are listed in 

the Surface Properties section of the report with integral distribution.     



 
 

 

    

SimuLEDView User Manual 10 of 19 

 

� For active region: 

� Number of Rays – number of rays emitted from the given mesh cell. For a 

uniform emission intensity this quantity is proportional to the cell area. 

� Emission Density (W/cm2) – local intensity of the light emission. This 

variable duplicates the Light Emission Intensity in SpeCLED output file 

used as input data for the RATRO computations 

� Extraction (W/cm2) – intensity of the extracted light emitted from the given 

location of the active region 

� Extraction Efficiency (%) – efficiency of the extraction of light emitted from 

the given location of the active region calculated as the ratio of 

Extraction to Emission Density 

4.2 Frames 

If the loaded SpeCLED file contains several die sections (i.e. electrodes and Z-planes in 

addition to the active region) or several active region files are loaded, distributions 

corresponding to each zone are available using Frames section at the right hand side of the 

graphics window. Frames section contains the list of available frames which include: 

� For electrodes: 

� n-electrode and p-electrode 

� For Z-planes: 

� z-coordinates of each horizontal section  

� For multiple active regions: 

� Values of bias 

 

When a RATRO file is loaded, the Frames section includes: 

� For the Far-Field Region: 

� Top and Bottom spheres 

� For the Near-Field Regions: 

� All external chip surfaces 

 

The Frames section can be hidden using the button Frames at the right hand side on bottom 

of the window.  
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Fig. 3 

4.3 Flood 

The Flood mode is used to visualize the 2D distribution of the current variable (i.e. variable 

on the selected Variables tab). It is activated by the button  in the Modes section at the 

right hand side of the bottom toolbar. 

Displaying of the flood legend is governed by the  button at the left hand side of the 

bottom toolbar.  

Customization of the flood mode is available via the Flood menu item on top of the window. 

This opens the Flood Options dialog window (see Fig. 3).  

4.4 Contour 

The Contour mode can be used to visualize the 2D distribution of the current variable in 

addition to flooding the image. It is activated by the button  in the Modes section at the 

right hand side of the bottom toolbar. 

The set of contours can be customized independently of the Flood options via the Contour 

menu item on top of the window. This opens the Contour Options dialog window (see Fig. 

4). 
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Fig. 4 

4.5 Vector Field of the Electric Current 

The Vector mode can be used to visualize the vector field of the current. It is activated by the 

button  in the Modes section at the right hand side of the bottom toolbar. Note that for a 

better visualization Jz is directed upwards, so that the direction of electron movement is 

used as the direction of the current vectors (i.e. its direction is opposite to the conventional 

current direction). 

 

Customization of the vector mode is available via the Vector menu item on top of the 

window. This opens the Vector dialog window (see Fig. 5).  

Two types of vectors are available in visualization of SpeCLED results. 

� Horizontal projections of current vectors. This is available in Z-Planes or Electrodes 

frames only. The user can specify these vectors by selecting (jx jy) item in the Vector 

combo box on top of the Vector dialog window.   

� Vertical projections of current vectors. This is available in all frames, including the 

Active Region. The user can specify these vectors by selecting (Null jz) item in the 

Vector combo box on top of the Vector dialog window.   
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The vector length can be of a fixed or current value dependent size. Displaying of the 

reference vector is governed by the  button at the left hand side of the bottom toolbar. 

 

Fig. 5 

 

4.6 Die Domains and Computational Grid  

Visualization of the boundaries of chip elements is governed by the  button at the right 

hand side of the bottom toolbar. 

Visualization of the computational grid is governed by the  button at the right hand side of 

the bottom toolbar. 

4.7 Probe 

The following probe modes are available: 
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� Mouse Probe of the Current Variable is available on pressing the  button 

(Indicator for Current Variable) at the left hand side of the bottom toolbar. In this 

mode the value of the active variable is shown on white background in a small 

rectangle under the cursor. 

� Mouse Probe of All Variables is available on pressing the  button (Indicator for 

All Variables) at the left hand side of the bottom toolbar. In this mode the values of all 

variables are shown in Watch dialog window (see Fig. 6). The values are 

automatically updated on displacement of the mouse cursor.  

 

Fig. 6 

� Point Probe mode allows the user to view the values of all variables at a set of 

discrete probe points. It is available via the Probe -> Point Probe menu item on top of 

the window. This opens the Point Probe dialog window (see Fig. 7) which provides 

visualization of all variables at each probe point, specification of new probe points 

and displacement of the existing ones. To specify a new probe point the user should 

click the left mouse button keeping the Shift key pressed. 
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Fig. 7 

� Line Probe mode provides visualization of 1D distributions along the user defined 

cross-sections. It is available via the Probe -> Line Probe menu item on top of the 

window. This opens the Line Probe dialog window (see Fig. 8) which provides 1D 

plots of the distributions of all variables along the specified line, specification of new 

lines, and displacement of the endpoints of the existing ones. 

To specify a new probe line the user should twice click the left mouse button keeping the 

Shift key pressed, assigning the first and the last endpoints. 

To move the first point of an existing line the user should specify its new position by 

clicking the left mouse button keeping the Alt key pressed. To move the second point of 

an existing line the user should first swap the endpoints by pressing the Swap Ends 

button end then to specify its new position by clicking the left mouse button keeping the 

Alt key pressed 

In addition to 1D plot the probe data are presented as a table that can be saved in a text 

file.  
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Fig. 8 

� Frame Probe mode provides visualization of 1D distributions along the vertical die 

cross-section in Z-Planes mode. Visualization of frame probes is available via the 

Probe -> Frame Probe menu item on top of the window. This opens the Frame Probe 

dialog window (see Fig. 9) which provides a bar diagram of all variables along the 

vertical cross-section, specification of new cross-sections which are defined by their x 

and y coordinates, and displacement of the existing ones. The bars on the diagram 

correspond to the discrete Z-planes. 

To specify a new probe cross-section the user should click the left mouse button keeping 

the Shift key pressed. 

In addition to 1D plot the probe data are presented as a table that can be saved in a text 
file. 
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Fig. 9 

4.8 Calculator 

The Calculator option allows the user to compute and display new variables. It is available 

via the Calculator menu item on top of the window that opens the Calculator window. To 

specify a new variable the user should press the New button and enter the name of the new 

variable and its definition as a function of the existing variables. The names of the existing 

variables are defined by the names typed on the Variable tabs omitting the ending 

dimensionality. For example, the temperature in Kelvin is shown in tab “T,[K]” . The Celsius 

temperature can be introduced as “TC=T-273.16”. 

Note that the variable name can not coincide with a name of already existing variable.  

The new variable is automatically added to the Variable tabs. The calculator window 

contains the list of all user-defined variables so the expressions of the existing user-defined 

variables can be edited.  

4.9  Image Options 

The Picture menu allows the user to customize the image and to save it to a file. It contains 

the following items: 
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� Contrast allows the user to change the saturation of the flooding colors and contrasts 

(from Black to Light Gray) of Grid lines (see Fig. 10).  

� Save in .bmp file allows the user can save the image in a file. 

 

Fig. 10 

 

5 Radiation Pattern 

 

Fig. 11 

For RATRO output files, visualization of the radiation pattern is available via the Probe -> 

Radiation Pattern menu item on top of the window. This opens the Radiation Pattern dialog 

window (see Fig. 11) which provides 1D plot for a selected orientation. The plots can be 

plotted either in polar (Polar tab) or Cartesian (Chart tab) coordinates. Horizontal (Angle = 0) 
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and vertical (Angle = 90°) directions are assigned by default. The user can also specify an 

arbitrary angle of the plot. 

The radiation patterns are generated using the far-field distribution calculated for the given 

sphere radius. So the Probe -> Radiation Pattern menu item is only available when Far-Field 

Region mode is selected. The radiation patterns are available for the following quantities: 

� Radiant Intensity (W/sr) 

� Radiance (W/(sr⋅m2)) 

� Luminous Intensity (cd) 

� Luminance (cd/m2) 

 

Fig. 12 

6 RATRO 3D View 

For RATRO output files, a 3D visualization of the light extraction from the LED chip is 

available. The 3D View window (see Fig. 12) is activated by pressing the 3D LED button 

located on the tool bar at the bottom of the window. It provides intuitive visualization of light 

extraction though all chip surfaces. The image can be rotated by the left mouse button, 

moved by the right mouse button, and zoomed by the middle mouse button or by mouse 

wheel. 


